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File and Folder Management
A Guide to this Instructor’s Manual:

We have designed this Instructor’s Manual to supplement and enhance your teaching experience through classroom activities and a cohesive chapter summary.  

This document is organized chronologically, using the same headings in red that you see in the textbook. Under each heading you will find (in order): Lecture Notes that summarize the section, Figures and Boxes found in the section, if any, Teacher Tips, Classroom Activities, and Lab Activities. Pay special attention to teaching tips, and activities geared toward quizzing your students, enhancing their critical thinking skills, and encouraging experimentation within the software. 
In addition to this Instructor’s Manual, our Instructor’s Resources CD also contains PowerPoint Presentations, Test Banks, and other supplements to aid in your teaching experience. 

For your students: 

Our latest online feature, CourseCasts, is a library of weekly podcasts designed to keep your students up to date with the latest in technology news.  Direct your students to http://coursecasts.course.com, where they can download the most recent CourseCast onto their mp3 player. Ken Baldauf, host of CourseCasts, is a faculty member of the Florida State University Computer Science Department where he is responsible for teaching technology classes to thousands of FSU students each year. Ken is an expert in the latest technology and sorts through and aggregates the most pertinent news and information for CourseCasts so your students can spend their time enjoying technology, rather than trying to figure it out. Open or close your lecture with a discussion based on the latest CourseCast.
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Chapter Objectives

Students will have mastered the material in this chapter when they can:

· View the contents of a drive and folder using the Computer folder window
· View the properties of files and folders

· Find files and folders from a folder window
· Find files and folders using Search

· Cascade, stack, and view windows side by side on the desktop

· View the contents of the Pictures folder window

· Open and use the Windows Photo Gallery

· View pictures as a slide show

· E-mail a picture

· View the contents of the Music folder window

· View information about an audio file

· Play an audio file using Windows Media Player

· Create a backup on a USB drive and a CD

· Restore a folder from a backup on a USB drive
WIN 150, Introduction
LECTURE NOTES

· Use the Overview on page WIN 150 to discuss how students will manage their files and folders using options in the Computer, Documents, Pictures, Music, and Public folders
· Use the Overview on page WIN 150 to discuss how students will display multiple open windows on the desktop and how they will backup and restore files and folders
CLASSROOM ACTIVITIES

Class Discussion: Ask students to describe their experiences, if any, managing files and folders using other operating systems, such as Windows XP or Windows 2000.
WIN 150, Plan Ahead: Working with the Windows Vista Desktop
LECTURE NOTES

· Review the basic knowledge students must have to manage their files and folders using Windows Vista operating system features
CLASSROOM ACTIVITIES

Class Discussion: Each user account may have different rights and permissions. Why?

WIN 151, The Computer Folder Window
LECTURE NOTES

· Define the terms Computer command, folder window, Local Disk (C:) icon, hard disk, disk label, RW, property, tooltip, Windows folder, and indexed location
· Discuss the general elements in a folder window
· Demonstrate how to open and maximize the Computer folder window
· Describe the specific elements and icons in the Computer folder window

· Demonstrate how to open, review, and close the Properties dialog box for a device listed in the Computer folder window

· Demonstrate how to switch folders using the Address bar

· Demonstrate how to view the contents of a drive

· Describe how to view the properties of a folder using a tooltip and the folder window Details pane

· Demonstrate how to search for files and folders using the Search box in the folder window and using the Search window

· Compare a Normal search with an Advanced Search
FIGURE: 3-1, 3-2, 3-3, 3-4, 3-5, 3-6, 3-7, 3-8, 3-9, 3-10, 3-11, 3-12, 3-13, 3-14, 3-15, 3-16, 3-17, 3-18, 3-19
TEACHER TIP

Remind students why there likely are differences between the contents of folders students see on their lab or home computers and the illustrations in this chapter.
BOXES

WIN 152, BTW: Remind students that they may see some icons on their home or lab computers that they do not recognize because software vendors create hundreds of icons to represent their products or because third-party icons may be used to represent files and folders.
WIN 154, Other Ways: You can right-click the C: drive icon and then click the Properties command on the shortcut menu to open the C: drive’s Properties dialog box. You can also select the C: drive icon, press the ALT key to display the folder window’s menu bar, click the File menu, and click the Properties command. Finally, you can select the C: drive icon and press the ALT + ENTER keys to open the drive’s Properties dialog box.
WIN 155, Other Ways: To close the C: drive’s Properties dialog box, you can also click the Cancel button, the Close button, or press the ESC key.
WIN 158, Other Ways: To view the contents of the C:  drive, right-click the drive icon and click the Open command on the shortcut menu, or click the drive icon and press the ENTER key.
WIN 163, Other Ways: You can right-click the Windows folder icon and click the Open command on the shortcut menu, or click the Windows folder icon and press the ENTER key, to view the contents of the Windows folder.

WIN 166, BTW: By default, hidden files and folders are not displayed in a file listing. Software vendors may place hidden files and folders on your hard disk that are critical to the operation of their installed application programs. You should not delete a hidden file as doing so may interrupt how or whether an application program works.

CLASSROOM ACTIVITIES

Quick Quiz:

1. A(n) ____ window may contain multiple elements including an Address bar, a toolbar, and the Details pane. (Answer: folder)

2. Local Disk (C:) is an example of a disk ____. (Answer: label)

3. The Devices with Removable Storage group in the Computer folder window includes icons for CD or ____ drives. (Answer: DVD)

LAB ACTIVITIES

WIN 152, Complete the steps To Open and Maximize the Computer Folder Window.

WIN 153, Complete the steps To Display Properties for the Local Disk (C:) Drive in the Details Pane.
WIN 154, Complete the steps To Display the Local Disk (C:) Properties Dialog Box.

WIN 155, Complete the steps To Close the Local Disk (C:) Properties Dialog Box.

WIN 155–157, Complete the steps To Switch Folders Using the Address Bar.
WIN 158, Complete the steps To View the Contents of a Drive.
WIN 159, Complete the steps To Preview the Properties for a Folder.

WIN 160, Complete the steps To Display Properties for the Windows Folder in the Details Pane.

WIN 161–162, Complete the steps To Display All of the Properties for the Windows Folder.

WIN 162, Complete the steps To Close the Properties Dialog Box.

WIN 163, Complete the steps To View the Contents of a Folder.

WIN 164, Complete the steps To Search for a File and Folder in a Folder Window.

WIN 165, Complete the steps To Return to the Computer Folder Window.

WIN 166–167, Complete the steps To Search for Files Using Advanced Search.

WIN 168, Complete the steps To Close the Search Window.

WIN 168, Managing Open Windows
LECTURE NOTES

· Demonstrate how to cascade multiple open windows 
· Describe how to make a specific window in multiple cascading windows the active window

· Demonstrate how to undo cascading
· Demonstrate how to stack multiple open windows and then undo the stacked windows

· Demonstrate how to show multiple open windows side by side and then undo the side by side view

FIGURES: 3-20, 3-21, 3-22, 3-23, 3-24, 3-25, 3-26, 3-27, 3-28, 3-29, 3-30, 3-31, 3-32
BOXES

WIN 168, BTW: Note that having multiple open windows on the desktop may intimidate some users who find it easier to work in one maximized window.
WIN 169, Other Ways: To cascade multiple open windows, you can right-click an open area on the taskbar and then press the D key.

WIN 170, Other Ways: To make a window the active window, click the window’s taskbar button, press the ALT + TAB keys until the desired window is selected, or click anywhere inside the desired window.

WIN 171, Other Ways: To undo cascading, right-click an open area on the taskbar and press the U key, or press the CTRL + Z keys.

WIN 172, Other Ways: To stack open windows, right-click an open area on the taskbar, press the T key until the Show Windows Stacked command is selected, and then press the ENTER key.

WIN 173. Other Ways: To undo stacked windows, right-click an open area on the taskbar and press the U key, or press the CTRL + Z keys.

WIN 174, Other Ways: To show windows side by side, right-click an open area on the taskbar and press the I key.

WIN 175, Other Ways: To undo showing windows side by side, right-click an open area on the taskbar and press the U key, or press the CTRL + Z keys.

CLASSROOM ACTIVITIES
Class Discussion: What are the advantages and disadvantages of cascading, stacking, and showing side by side multiple open windows?
Quick Quiz:

1. ____ windows overlap one another in an organized manner. (Answer: Cascading)

2. ____ windows allow you to view part of each open window’s contents. (Answer: Stacked)

3. ____ windows are vertical on the desktop. (Answer: Side by side)

LAB ACTIVITIES

WIN 168, Complete the steps To Open Windows.
WIN 169, Complete the steps To Cascade Open Windows.

WIN 170, Complete the steps To Make a Window the Active Window.

WIN 171, Complete the steps To Undo Cascading.

WIN 172, Complete the steps To Stack Open Windows.

WIN 173, Complete the steps To Undo Show Windows Stacked.
WIN 174, Complete the steps To Show Windows Side by Side.

WIN 175, Complete the steps To Undo Show Windows Side by Side.

WIN 175, The Pictures Folder
LECTURE NOTES

· Define the terms copyright, copy and paste method, copy, Clipboard, paste, Windows Photo Gallery, Slide Show, and electronic mail (e-mail)
· Describe how to organize pictures in the Pictures folder
· Demonstrate how to search for pictures

· Demonstrate how to select multiple pictures and copy them into a different folder

· Demonstrate how to create a new folder within the Pictures folder and then move multiple files into the new folder

· Describe how to refresh the view of a folder’s contents

· Describe the properties associated with pictures

· Demonstrate how to use the Details pane to change picture properties

· Demonstrate how to view individual pictures in the Windows Photo Gallery and how to view pictures in a slide show

· Discuss problems associated with e-mailing large picture files and how Windows Vista handles this problem

FIGURES:  3-33, 3-34, 3-35, 3-36, 3-37, 3-38, 3-39, 3-40, 3-41, 3-42, 3-43, 3-44, 3-45, 3-46, 3-47, 3-48, 3-49, 3-50, 3-51, 3-52, 3-53, 3-54, 3-55, 3-56, 3-57, 3-58, 3-59
TEACHER TIP

You may choose to have students find pictures in the public domain, such as those at many U.S. government sites. Then have students discuss the difference between using pictures found in the public domain and using pictures protected by copyright law. You may also choose to provide examples of permission or ownership captions generally used with pictures.
BOXES

WIN 179, Other Ways: You can copy and paste picture files between windows using the Copy and Paste commands on the Edit menu. Select the file(s) to be copied, press the ALT key to display the folder window’s menu bar, click the Edit menu, and click the Copy command. Then switch to the window where you want to paste the file, press the ALT key and click the Paste command on the Edit menu. Alternatively, you can select the file(s), press the ALT key and click the Copy to Folder command on the Edit menu to open the Copy Items dialog box. Select the desired destination folder and click the Copy button. Finally, you can select the file(s) and press the CTRL + C keys to copy the files, switch to the destination window, and press the CTRL + V keys to paste the files.
WIN 181, Other Ways: You can create a new folder by pressing the ALT key to view the folder window’s menu bar, then clicking the File menu, pointing to the New command, and clicking the Folder command. You then type the folder name and press the ENTER key. Alternatively, you can press the ALT + F keys, the W key twice, the RIGHT ARROW, and the F key. Then type the folder name and press the ENTER key.
WIN 182, Other Ways: You can drag a file icon to a folder icon to move the file into the folder. You can also right-click a file icon, click the Cut command on the shortcut menu. Then right-click the folder icon and click the Paste command on the shortcut menu.
WIN 183, Other Ways: You can refresh the view of folder contents by pressing the ALT key to display the folder window’s menu bar, clicking the View menu, and clicking the Refresh command.
WIN 186 Other Ways: You can change a picture’s properties by right-clicking the picture file icon and clicking Properties on the shortcut menu to open the Properties dialog box. Click the Details tab in the Properties dialog box and change the desired properties, such as adding a tag or changing the rating. Then click OK to save the changes and close the dialog box.
WIN 187, Other Ways: You can right-click a picture file icon and click the Preview command on the shortcut menu to open the picture file in the Windows Photo Gallery.
CLASSROOM ACTIVITIES

Class Discussion: You must confirm that you are allowed to use a picture for an intended purpose before you use it. Why?

Quick Quiz:

1. Pictures that come with Windows Vista are yours to use any way you like. True or False? (Answer: False; the pictures belong to Microsoft and must be used according to the rights given to you by Microsoft)

2. Creating a new folder in which to store related files is a good way to find the files more easily. True or False? (Answer: True)

3. Adding meaningful tags to pictures helps classify them. True or False? (Answer. True)

4. Windows Vista automatically compresses large image files before attaching them to an e-mail message. True or False? (Answer: True)

LAB ACTIVITIES

WIN 176, Complete the steps To Search for Pictures.
WIN 177–179, Complete the steps To Copy Files to the Pictures Folder.

WIN 179, Complete the steps To Close the Search Results Window.

WIN 180–181, Complete the steps To Create a Folder in the Pictures Folder.

WIN 182, Complete the steps To Move Multiple Files into a Folder.

WIN 183, Complete the steps To Refresh the Image on a Folder.
WIN 184–186, Complete the steps To View and Change the Properties of a Picture.

WIN 187, Complete the steps To Open a Picture in the Windows Photo Gallery.
WIN 188, Complete the steps To Navigate through Your Pictures.
WIN 189, Complete the steps To Close the Windows Photo Gallery.

WIN 189, Complete the steps To View Your Pictures as a Slide Show.

WIN 190, Complete the steps To End a Slide Show.
WIN 191–192, Complete the steps To E-Mail a Picture.
WIN 193, The Music Folder
LECTURE NOTES

· Define the terms Music folder, rip, burn, Public folder, and Windows Media Player
· Describe how to use the Music folder to store and work with music files
· Discuss different music file types

· Demonstrate how to open the Music folder from the Favorite Links list or switch to the already open Music folder using the taskbar button

· Describe the Public folder and demonstrate how to open it

· Describe the Sample Music folder and demonstrate how to open it

· Describe the various properties associated with a music file

· Demonstrate how to start the Windows Media Player and play a music file

· Demonstrate how to close the Windows Media Player

FIGURES: 3-60, 3-61, 3-62, 3-63, 3-64, 3-65, 3-66, 3-67, 3-68, 3-69
TEACHER TIP

You may choose to invite a guest speaker to discuss picture and music file copyright issues with the class.
CLASSROOM ACTIVITIES

Critical Thinking: “It is illegal to download and share music that you do not own.” Why? Who gets hurt when picture, movie, or music copyrights are violated? How?
Group Activity: Break students into groups and assign each group to use a search tool such as Google, Ask.com, Yahoo! Search, or Live Search to learn more about music and picture copyright protections and then report back to class on what they learned.

LAB ACTIVITIES

WIN 193, Complete the steps To Switch to the Music Folder.

WIN 194, Complete the steps To Open the Public Folder.
WIN 194, Complete the steps To Return to the Music Folder.
WIN 195, Complete the steps To Open the Sample Music Folder.

WIN 195–197, Complete the steps To View Information about a Music File.

WIN 198, Complete the steps To Reset the Rating for a Music File.

WIN 199, Complete the steps To Play a Music File in Windows Media Player.

WIN 200, Complete the steps To Pause a Music File.

WIN 200, Complete the steps To Close Windows Media Player.

WIN 200, Backing Up Files and Folders
LECTURE NOTES

· Define the terms backup ,scheduled backup, restore, and Live File System
· Remind students that it is important to create a backup copy of important files and folders
· Note that backup file copies should be stored on a separate device from the original files
· Discuss restoring backup copies when original files are lost or destroyed

· Demonstrate how to rename a folder

· Remind students how to create a backup on a USB drive

· Describe the Live File System
· Demonstrate how to create a backup on a CD

· Demonstrate how to restore a folder from a backup copy
FIGURES: 3-70, 3-71, 3-72, 3-73, 3-74, 3-75, 3-76, 3-77, 3-78, 3-79, 3-80, 3-81, 3-82, 3-83, 3-84, 3-85, 3-86, 3-87, 3-88, 3-89, 3-90
TEACHER TIP

You may choose to invite a guest speaker to discuss the importance of installed and up-to-date virus and spyware protection software on personal computers and the importance of maintaining current backup copies of critical files.
CLASSROOM ACTIVITIES

Class Discussion: Ask students to share their experiences, if any, with problems related to lost or damaged files and inadequate backup procedures and files.

Quick Quiz:

1. Backing up files and folders is a security aid; if something happens to your primary copy of a file or folder, you can restore it from the backup. True or False? (Answer: True)

2. A(n) ____ backup always occurs at predetermined dates and times. (Answer: scheduled)

3. It is a good idea to store your backup files on the same computer as the original files. True or False? (Answer: False; backup files should be stored in a location away from the computer that contains the original files)

LAB ACTIVITIES

WIN 201, Complete the steps To Insert a USB Drive and Open It in a Folder Window.

WIN 201–203, Complete the steps To Create a Backup on a USB Drive.

WIN 203–205, Complete the steps To Rename a Folder.
WIN 206–208, Complete the steps To Create a Backup on a CD.
WIN 208–209, Complete the steps To Eject a CD.
WIN 210, Complete the steps To Close the Computer Folder Window.
WIN 210–212, Complete the steps To Restore a Folder from a Backup.

WIN 212, Complete the steps To Delete a Folder from the Pictures Folder.

WIN 212, Complete the steps To Remove the USB Drive.

WIN 213, Complete the steps To Log Off from and Turn Off the Computer.

WIN 213–224, End of Chapter Material
· Chapter Summary provides a brief review of key topics in the chapter and a list of key skills referenced by page number.

· Learn It Online is a series of online student exercises that test your knowledge of chapter content and key terms.

· Apply Your Knowledge is a student assignment that helps you to reinforce the skills and apply the concepts you learned in this chapter.

· Extend Your Knowledge is a student assignment that challenges you to extend the skills you learned in this chapter and to experiment with new skills. You may need to use Help to complete the assignment.

· In the Lab is a series of student assignments that ask you to design and/or create a presentation using the guidelines, concepts, and skills presented in this chapter. The assignments are listed in order of increasing difficulty.

· Cases and Places is a series of student assignments where you apply your creative thinking and problem-solving skills to design and implement a solution.

Glossary of Key Terms

· backup (WIN 200)

· burn (WIN 193)

· Clipboard (WIN 177)

· Computer command (WIN 151)

· copy (WIN 177)

· copy and paste method (WIN 177)

· copyright (WIN 176)

· disk label (WIN 152)

· electronic mail (WIN 191)

· e-mail (WIN 191)

· folder window (WIN 151)

· hard disk (WIN 152)

· indexed location (WIN 165)

· Live File System (WIN 206)

· Local Disk (C:) icon (WIN 152)

· Music folder (WIN 193)

· paste (WIN 177)

· property (WIN 153)

· Public folder (WIN 194)

· restore (WIN 201)

· rip (WIN 193)

· RW (WIN 152)

· scheduled backup (WIN 201)

· Slide Show (WIN 189)

· tooltip (WIN 159)

· Windows folder (WIN 159)

· Windows Media Player (WIN 199)

· Windows Photo Gallery (WIN 187)
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